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Section : General Knowledge

Q.1 Ielis 2024 ¥, FAgfaf@d ¥ A 1A YR g3 fbbe I &1 141 4= oI g fHan
T oAT?

Ans  x 1.3gA Gfds
x 2. 3130d 3PRB
x 3. 3fd oAt
o 4. iR
0.2 Ad«€R 2024 ¥, L b1 378 Fron fyenergd AT & ded, Rendt faenfd o1 sifean
feed-ft Bor A gar= & sresfi?

Ans  x 1.%8.5c9 dod

v 2.37.5 9 dob
X 3.34.5419 db
X 4.35.5 G db
0.3 Gf3YT UIRd 4R 400 A AP aul dP ATHT B3I dlcll Ygell de’ At Fuferfad 4 3
Bl A1?
Ans | x 1. BB AT9LA
2. ITAdTg ASTdLA
X 3. SHA Feddd

x 4. AFHE ASTAA
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Q.4 f3A4r #, 2025 a4y WA T & SR1A, FEffEd 7 9 169 99 AY$ W@ JaR &1
91T 31AT?

Ans | 1. AT B ygell s HTHRY HE Bl 3aTT
x 2. 3IARTEIT AT WRey ~1dTerd I g1
X 3. 99 &Y UEA Bl YURY
x 4. AP fageasial ufcRied HHad PI 3911

Q.5 HRd IRBR AT 1919 F QR fafedr ARd ST a=ARI S 41?2
Ans  x 1.8 Hidl
x 2.8 fier
« 3. I I=IBIS
X 4. 718 AR
0.6 fHferfad & A 4 Ad1 I 1857 & fagie & WA foran, 5 yom MRd Jddr Jama
Sl SATdT &2

Ans | x 1. SR dd W[4
o 2. eTR HrdRIH 5]
X 3. 711 A8d
x 4. PR g
0.7 fFuferfEd ¥  o19-31 &7 ardia Sl IRAVST & fere s siar &2
Ans | x 1. HE Pl Wral
v 2. T Ered
x 3. 37 °ret
x 4. TS ardt
0.8 2011 & FPIVAT & Aibsl AUdi dadar e fd 199 MAferaa &1 uardt & Ary, IRd
&1 A9 TS 3a1E arelr A3
Ans | x 1.HERTY
X 2. AT
x 3. fogr

@ 4. 3R Y
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09 AFIRanAfifa =~ AdARF S ARAdygm H AN b1 18 |
Ans | x1.1984; 1995

x 2.1982; 1991

¢ 3.1986; 1992

x 4.1980; 1992

Q.10 1757 ¥ i3 deiisd A &d & Adrs A fAgferfad & J sa-3dt @s18 Sfdy &i?
Ans | x 1. gfeferare & @erg
X 2. RR &I 78T

3. @l T @e18
x 4. 3P bl @Sl

0.11 fAgferfRad & I $19-UT1 91 2024 T faT (BRICS) &1 31T &dT AGUT SN2
Ans  x1.9Rd

v 2. 59

x 3. STl

x 4. EfeyuT 375hrepT

0.12 IR g & e & fAgferfad § I ®1-91 $AFleld 8?
Ans | 1. 92m FaiAd g 31 1954 H 3R & 318 &

x 2. 99 & &l UG gl

x 3. I9e, Vg IR R U ferh A &

x 4. AFAFY IS B THA B JHdl ¢ 3R IATHH B Jb el g

0.13 &I AcuEP H1F [l gIRT 3ghTe U U ‘olid Jdad ud’ &1 3897 1 U112
Ans | x 1. \fgel3i 3R g=i & fav 48 A Braghl Y& B!

X 2. IS FHCTAT Pl b WY ST Yal B

x 3. 37fearst Ay SriwH & 3ddTd IRUNE &l B Jaral o

¢ 4. 100 T&At & @9 & 3iasid ey & 3uafedl &l gafefd &
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0.14 R AT & fHT 3B ¥ I e ¢ 1P o fadas 337 A1 § U 12l 151
SITUM?

Ans »1.109
x2.110
% 3.108

x 4. 111

Q.15 Bsd! (Karaivetti) 9&fl IMARTT HIRd & HA I § ¥qyd &2
Ans  x 1.HERTY
x 2. [5RTd
« 3. dHTTg
x 4. Heg UGQA
Q.16 2025 # & YRANF &1 Y337 7 AR &P a1 I IR 3MTFB AT Bl

AT BId gU A el fAerauiidrvl & felv U 3 <1 dledl IR Aediads
Uie AR fSieell faefid 6 82

Ans | x 1. 9Rd gdl scifRPped faiffics

X 2. AR 3afer srgHend IoTo
v 3. 38T 37gHemT Ud fasrd Ire
x 4. g v faifics

Q.17 FHffEd YISl Bl 39 RATY1 99 I YAferd S|

a. 3 JAIST i. 1828

b. ITH P9 e ii. 1873
c. AL eYPH JHIS iii. 1875
d. gl Y17 iv. 1897

Ans | x 1. a-ii; b-iv; c-i; d-iii
« 2. a-iii; b-iv; c-ii; d-i
x 3. a-i; b-ii; c-iii; d-iv

x 4. a-iv; b-i; c-iii; d-ii
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7

0.18 ®rie A1 fbg I ¥ /A 82
Ans 1. 3T%ES

X 2. HEIRTY

x 3. B3

x 4. Rfeepq

0.19 2019 ¥, YRd & g ArArefier Afed Adi= ArATeTy F ArArefiell b gl d&AT
fAretRd &1 18 o

Ans 134
x2.30
x3.27

x 4.25

0.20 YR UG H, YAE b1 BrAarel
Ans  x 1.@0Td ®Td

x 2. YITPIA

« 3. ST

x 4. T91 Bl

0.21 AfG R &1 e = §, °s’ BT 31 <’ &, T” b1 318 ‘+° &, 3% ‘U &1 39— &, oY Fgferfaa 7 @
feqer aiRomg 112 89M?

Ans | x1.64R2U16T8S 4
x2.70U38T10R2S1

«3.80T40U8S2R2

x4.965S1R3U24T4

4 IS ardl 2

GET IT ON
Google Play
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0.22 3 < 1€ dE f@en 1 A ofifiv 3R 3T MR IR YB U Yy &1 IR qAfSrel (eft
WY Uhd-3ib1 ABATT 1)
(98)153728496137542896371549826 (al0)

&t TS @en 7 3 A1 Q) A 3711¥S guf 3°f F@AT vb-quY & S Tl 7 fpa-it aR 3wt &2

Ans w.é‘r

x 2.d9
x 3.0 ot 78

x 4. dR

0.23 Ifg ‘+’ 3R ‘— Bl RWR dqol AT AT dAT x° 3R ‘=” B R dG fgdr e, dl
fgferRad afieor ¥ yy-fag (?) & =& 93 &7 302

20:5-32x4+6=7
Ans  x1.162

v 2.102

x 3.132

x 4.142

0.24 &1 718 g@d ° 9Y-¥€ (?) & R&ATH IR T 3777 91fge?

32,37,47,62,82,7
Ans x1.108

x 2.109

% 3.106

¢ 4.107

0.25 & 18 9@t § Y &g (?) & AT U T 3771 A1fgU?

153253811137
Ans  x 1.151

x 2.153

« 3.152

x 4.150
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0.26 A < 718 @ f@en 1 A ofifSiv 3R 3T MR IR YB U Uy &1 3R el (qeft
HSAT0 UHd-3b1T J=AT &)
(f19)15372849613754289637154982 6 (3I0)

&1 1% j@ar § W& ‘5’ fed-t 9% 3R 82
Ans 1. dld

x 2.9R

x 3.0 ot 78

x 4.3

0.27 U URAR A BE AGH P, Q, R, S, T 3R U €1 Q 3R R faqifed &1 R &1 spellai g S &1 U
ST 7 R €1 P &7 9fe U &1 U &Y a1aT T &1
P&l T 3T Ade 87

Ans | 1.9 6 gdl
x 2. TTd
x 3. 930
x 4. Tdl
0.28 U fAfYd adid A SQ121 &1 Adel NL220 I 81 33 YPRR, 1G198 FI &g DB297 A &l
AT AP BT HLIRY BId §U, LJ299 BT Hee fQU ¢ faspeyl 7 I fFad 82
Ans  x1.FH397
x 2. FD398
« 3. GE398
x 4. GF397
0.29 U< NEWSPAPER ¥ Y@ R Bl 3350 quinrell o1 # 39& S d1g did 318R d 9l

feam ST & 3R yAS s $I 3034SH quinTean o0 7 3P e Usd ara 18R A dad A
STl &1 39 9bR 1 318R1 & Ag H fpd 38R S 4l 9R 01?2

Ans Jlapf
x2.T%
x 3. TS ot 78

x 4.
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Q.30 U, V, W, X 3R Y 3t f&em $I 3R AP gibr Us o9 4R 46 &1 U AR v FAeead ugidt
&1 W 3R X Aeedd usiHl &1 Y & fAdcan usidt v 3R X €, S4af® ¥, X & &I q18 3R
do1 21 99 F qIfg? BR IR 31 a1 82

Ans x1V
& 2. U
x3. W

x 4. X

0.31 39 A= $I 944 ISV BRI ABA0 Rt YR Adfdd & oy YR Fufaf@d ag=3
&1 TS0 39T § J&fed

(Are: sTfordia ARBATT J@AT3M B 375 ged il H dis a1, Quf YT uv 61 -t
TIfEU1 3T & felv 13 & eifre - 13 R MOy Jdfpare 3 6 13 3i
SISHT/=eT-1/3[0N BT, S f6AT ST ABAT 2113 BN 13R 3T ASAMIR MR 1IR3 W)
STt WfpATe &I Y srgafa L 21)

(7,3,15)
(8, 8, 21)

Ans »1.(4,18,27)
x 2.(12,4,23)
x 3.(26, 5, 61)

x 4.(8,12,22)
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Ans

Ans

=&

7

0.32 39 fa®bey Hfad &1 9g4 HIfHIC 371 def & @R HA & fee i3 & 18 nefa 7 uy Rg
(?) & 19 93 3|

G

N

?

—_

N

x 1. NzIPUG
X 2. NAIPVG
X 3. NZRPVG

v 4. NZIPVG

/)
3 )
/)

0.33 3135 quiHTell %7 & YR 4R JUMPER U [ATId db & AR QFNKVI I I&ferd 8l
COLLUSION 331 T & HFAR XLOOFHRLM ¥ J«fed &1 IHTT dd Bl HIIRUI Hd gUv
MARKET f&U 71U fadedl § 3 fpad ddfad &2

GET IT ON
Google Play
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Q.34 Fferf&d J@a-ZHl 1, ygell AT IR B IO AfPATT P IS AL XA U1t B
STt &1 DI-3t F@=AT3T gIRT X 31R ¥ &) gfavenfia fear sn arfge, arfe - & 918 3R
&1 QAT TBAT3M gIRT IATAR fHAT S arelr de, - & a1 3R 61 QA1 T30 gRI
IR fHU 11 dret def & Jur ar?

(Are: oty WTPATT ABAHT b1 37d g 3Pl H dis f9A1, gof I=A 3 gv 61 S
qTfgv| 3TER01 & felv 13 &) fifSre - 13 9= Ifordia Hfopare 3 fp 13 1

SSAT/=eT-1/3[0N BT, S fEAT ST ABAT 2113 BN 13R 3 TASMIR R 13IR3 W)
oIt ARBATE S B Hufa A8 21)

X:127 ::56: Y
Ans  x1.X=42,Y=157

x2.X=32,Y=167

& 3. X=42,Y =169

X 4.X=41,Y =168

Q.35 Ifg JWAT 1783426 T UdP fAyd 3id § 1 30T STV dAT YA I 3id § A 2 €171 310,
dl 39 9R -t 18 A 7 910 A N a1 Q10 A dIRR 3 $T OB T I?
Ans x1.18

v2.16
x3.12

x 4.14
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0.36 NG 13 U® fAffd afie d o1-1 d H&fAd &1 FL 19 3 a3 GN 5 A Id&fdad &1 Jurd dob
&1 ARV Bd §U, Ul 22 f{U ¢ fadedl § & fead Aefad &2

Ans  x 1.UL12

« 2. VK 8

x3.UK8

x 4. VL 12

Q.37 3iSH quinten %9 g nreiRd, FEferf@d IR sgR-ayg 4 A d14 fed Afgd adie d ve
I § 3R 9 UPR U YU 9-1d &1 BI-31 378R-9Yg 39 I & Adfaa I8 &2
(AVS: 3T HGR-AYE, HER-AYE | A1 /R b1 &A1 A1 39H R/yfA 93 3menRa 1l
gl)
Ans  x 1.SVT
x 2. BEC
« 3. DHE
X 4. ORP
0.38 B Afb U, V, W, X, F 3R G U el A1 & IRd: A1 & Hg 61 3R AMAE dd 1S &1 G

IMNMWETHTFaAaVIBT2IW, USSP IT0 A IR WTT IR ST &1 F, U & SI'b 910 daT 21 F
P 10 A Bl B33 1R X 3R F F 9 fpda b 38 &2

Ans  x1.d4
;(’Z.a
v 3 AR
x 4. Udb

0.39 fFufearf@a e g@en &1 g o 3R A 99 &1 3R | (Jofi ST Fad ve-3ib1g
W@t g1)

(d0)447524798326958498245592 83 8(gI0)

a7 gfaann I woft fawy J=An¢ ger & Sy, a1 3t M F@ a1E 3R A @ e
Ans | x1.2

x2.4

3.8

x4.6
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0.40 FHferf@d IR a<-Fui § F i v A afid I aur € 3R 39 YbR d U Jgg §-1d
&1 BT AT A<-PH 39 AYg A Adfda 98 &2

(e =l &) Arefep 315N =gl & ®Y & gr41 771 A1fR0 3R I 9I=g, A5 |
ERT /ST /IR 1 AT & 3R GR Ub-gar A AdfAd el 817 =ifgel)

Ans x 1. Active: Lazy
x 2. Beautiful : Ugly
x 3. After : Before

« 4. Bitter : Sour

Section : General English and Comprehension

Q.41 Select the option that can be used as a one-word substitute for the given group

of words.

The art of beautiful handwriting
Ans 1. Calligraphy
x 2. Cacography
x 3. Choreography
x 4. Cartography
Q.42 Select the most appropriate option to fill in the blank.
She  to school every day.
Ans x1.gone
X 2.80
« 3. goes

x 4.going

Q.43 Select the most appropriate option to fill in the blank.

Hiking is difficult fun.
Ans | x 1. therefore
« 2. but
x 3.50

x 4. or
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Q.44 Select the most appropriate synonym of the given word.

Eternal
Ans  x 1. Fleeting
« 2. Enduring
x 3. Fragile

x 4. Temporary

Q.45 Select the most appropriate meaning of the given idiom.

Back to square one
Ans | x 1. When one plans to do something because of the other plan
« 2. When one takes a new course of action after a failed one
x 3. When one is in a difficult situation

x 4. One should be aware of a potential danger to protect oneself

GET IT ON
Google Play
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Comprehension:

Read the given passage carefully and answer the questions that follow.

Power foods are foods that provide rich levels of nutrients such as fibre, potassium, and
minerals. With people becoming increasingly health-conscious today, a lot of fitness
trainers encourage their clients to include these foods in their daily diet to increase
muscle development. There are various ways of incorporating power foods into your daily
diet. Of course, the key to enjoying power foods is proper preparation of these foods, the
use of seasonally fresh foods, and identifying your choice of flavour among power foods.
Some of the recommended power food combinations are those that are prepared in our
kitchens on a regular basis. Take for instance, the combination of chickpeas and onions.
This combination is a powerful source of iron, which is required by the body to transport
oxygen to its various parts. Iron deficiency can lead to anaemia, fatigue, brain fog, and

tiredness.

SubQuestion No : 46
Q.46 Why is iron required by the body?
Ans | x 1. To strengthen bones and teeth
% 2. To aid in the digestion of food
x 3. To regulate blood sugar levels

« 4. To transport oxygen to its various parts
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Comprehension:

Read the given passage carefully and answer the questions that follow.

Power foods are foods that provide rich levels of nutrients such as fibre, potassium, and
minerals. With people becoming increasingly health-conscious today, a lot of fitness
trainers encourage their clients to include these foods in their daily diet to increase
muscle development. There are various ways of incorporating power foods into your daily
diet. Of course, the key to enjoying power foods is proper preparation of these foods, the
use of seasonally fresh foods, and identifying your choice of flavour among power foods.
Some of the recommended power food combinations are those that are prepared in our
kitchens on a regular basis. Take for instance, the combination of chickpeas and onions.
This combination is a powerful source of iron, which is required by the body to transport
oxygen to its various parts. Iron deficiency can lead to anaemia, fatigue, brain fog, and

tiredness.

SubQuestion No : 47
Q.47 What are power foods rich in?
Ans | 1. Fibre, potassium, and minerals
x 2. Sugars, fats, and carbohydrates
x 3. Processed ingredients and artificial flavours

x 4. Proteins, vitamins, and antioxidants
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Comprehension:

Read the given passage carefully and answer the questions that follow.

Power foods are foods that provide rich levels of nutrients such as fibre, potassium, and
minerals. With people becoming increasingly health-conscious today, a lot of fitness
trainers encourage their clients to include these foods in their daily diet to increase
muscle development. There are various ways of incorporating power foods into your daily
diet. Of course, the key to enjoying power foods is proper preparation of these foods, the
use of seasonally fresh foods, and identifying your choice of flavour among power foods.
Some of the recommended power food combinations are those that are prepared in our
kitchens on a regular basis. Take for instance, the combination of chickpeas and onions.
This combination is a powerful source of iron, which is required by the body to transport
oxygen to its various parts. Iron deficiency can lead to anaemia, fatigue, brain fog, and

tiredness.

SubQuestion No : 48

Q.48 Select the most appropriate ANTONYM of the given word.

Provide
Ans x 1. Furnish
« 2. Reserve
x 3. Supply

x 4. Pursue
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Comprehension:

Read the given passage carefully and answer the questions that follow.

Power foods are foods that provide rich levels of nutrients such as fibre, potassium, and
minerals. With people becoming increasingly health-conscious today, a lot of fitness
trainers encourage their clients to include these foods in their daily diet to increase
muscle development. There are various ways of incorporating power foods into your daily
diet. Of course, the key to enjoying power foods is proper preparation of these foods, the
use of seasonally fresh foods, and identifying your choice of flavour among power foods.
Some of the recommended power food combinations are those that are prepared in our
kitchens on a regular basis. Take for instance, the combination of chickpeas and onions.
This combination is a powerful source of iron, which is required by the body to transport
oxygen to its various parts. Iron deficiency can lead to anaemia, fatigue, brain fog, and

tiredness.

SubQuestion No : 49
Q.49 Who encourages their clients to include power foods in their daily diet?
Ans  x 1. Nutritionists
x 2. Dieticians
« 3. Fitness trainers

x 4. Doctors
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Comprehension:

Read the given passage carefully and answer the questions that follow.

Power foods are foods that provide rich levels of nutrients such as fibre, potassium, and
minerals. With people becoming increasingly health-conscious today, a lot of fitness
trainers encourage their clients to include these foods in their daily diet to increase
muscle development. There are various ways of incorporating power foods into your daily
diet. Of course, the key to enjoying power foods is proper preparation of these foods, the
use of seasonally fresh foods, and identifying your choice of flavour among power foods.
Some of the recommended power food combinations are those that are prepared in our
kitchens on a regular basis. Take for instance, the combination of chickpeas and onions.
This combination is a powerful source of iron, which is required by the body to transport
oxygen to its various parts. Iron deficiency can lead to anaemia, fatigue, brain fog, and
tiredness.
SubQuestion No : 50

Q.50 Which of the following can be the suitable title for the passage?

Ans | & 1. Unlocking the Power of Nutrient-Rich Foods

% 2.Simple Steps to Prepare Delicious and Healthy Meals

x 3. Fitness and Diet: A Trainer's Guide to Muscle Development

% 4. The Importance of Iron in Our Daily Diet

Section : General Hindi and Comprehension

0.51 fordr1 &1 3fAd ¥ R7b 2T # M-
MaTet A 397 --- f&dnl

Ans  x 1.3°T4
& 2. 3T
x 3. 3ol

x 4. T
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Q.52

Ans

Q.53

Ans

Q.54

Ans

Q.55

Ans

247

“‘RRIT ddl 3187 eNbIfch BT T 37 82

x 1. 8 d¥WP 37ERT 81T
x 2. QMH &Id & W orT

3. U1 &1 ST fears 9 gsH

x 4. 3R § R ST

ol BT ey A= T 8-

x 1. G
¢ 2. aIReg
x 3. fadrof
x 4.5

I AT U Ad’ ellpifb &1 37 8-

x 1. 7% Ad Il & RIR
x 2. TS JATAT It P SRIR
x 3. ! gAY UHHA T8l 8l

v 4. IGHT UHHd G B1Y Bd &

'IcqSl oI faeliy UG s -

1.5
x 2. 3%

X 3. 3791

x 4.3PTe

GET IT ON
Google Play
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Comprehension:

f&T 7T Terier & 3memR 9 Agifed g4t & 3t Ifsre--

ciepda BT Sig I PR AN A Y& §3T| 3RIJ A b b JIMd TR BI IdH AT &
A &b PR A H TA dlrbdd o1l ot = Afeh 370 F91 ¥ U &, BT 9-1d 31 378 o],
B A AR & YT BIel A & MUIdIHS a8 81 Jai foresdl, ol 31 T 31 Jeard
et &1 el & THY AT LA 37 Blet bl IS faQivdr &t s1ef a7 31 & 3ot 59 gbg
AR AT Faell A BT §Id 3R 9 B A1 7eF T H Y. A Bl 54 g2ell b PR
T H g3 RACSRAIUS & BRI bl B off gyl cliepda o1 5 3157 o 1 37orevdl i) ¥ &1
5 TR b AHF BT FHY BT 1| T AT 372/aT YTAFIETHS b=l T gR1 T M|

SubQuestion No : 56
0.56 & fpA YBIR P clibdd BI =BT AT o--
Ans  x 1.3037d
X 2. A9 cAlbas
x 3. ufafAeres dipdy

@ 4. U8 AP

Comprehension:

f&T 7T Terier & 3memR TR Agifed g4 & 3t <Ifr--

ciepd BT Sig I & PR I A Y& §3T| 3RIG A by b FIMd TR BI IdH HIT &
AT &b PR A H TA dlibdd o1l At I Afeh 377 91 ¥ Ub &, BI-17 -7d 31 38 o],
BA A1 AR & YT BieT F & MRS a1 I8 &) Tal forsdl, ol 31 T 31 Ieerd
et &1 el & THY AT LA 37 Blet bl IS fadivdn &t sief 315 [T & 7ot YS9 gbg
AR AT Faell A BT §1d 3R 9 B A1 7eF T | Y. oAb Bl 514 geil b PR
I H g311 RACSRAIUS & BRI bl B off Tyl cliepda o1 5 34757 o 81 37erevdl o) ¥ &1
5 TR b MHF BT FHY BT 1| T AT 372/aT YTAFIeTHS cliepcd=l T gR1 HdT M

SubQuestion No : 57
0.57 19 ¥ & yI& &I faely o=x 8--
Ans .38
x 2. AT E
x 3. AdUI &

x 4. fagcaer
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Comprehension:

f&T 7T Terier & 3memR 9 Agifed g4t & 3t Ifsre--

e BT S I PR AN A Y& §IT| 3RIJ A b b JIMd TR BI IdH AT &
A &b PR A H TA dlrbdd o1l ot = Afeh 370 F91 ¥ U &, BT 9-1d 31 378 o],
B A1 AR & YT BTl A & NS a8 &1 Jai forsdl, o 31 T 31 Jeerd
et &1 el & THY AT LA 37 Blet bl IS faQivdr &t s1ef a7 31 & 3ot 59 gbg
AR AT Tael A HILT §Id 3R o B A1 7eF T H Y. oAb Bl 5H g2ell b PR
T H g3 RACSRAIUS & BRI bl B off gyl cliepda o1 5 3157 o 1 37orevdl i) ¥ &1
5 TR b AHF BT FHY BT 1| T AT 372/aT YTAFIETHS b=l T gR1 T M|

SubQuestion No : 58
Q.58 dlell & AT JFATAT FI fadwdr off--
Ans | x 1.7fdl & 3= T & @7 AT FAd & S BT Set o
« 2. 11 J97 ol I3 gobg geb? BI-1d a1 &
X 3. DI 14 & foTU AT & Areds I AAfei - sl o

X 4. 9 9T § Joft SN-YSY gebg gep? HIFA §1d &

Comprehension:

f&Q 310 STerier & 3meR 4R Fgifed g4 & 3 Gfsie--

e Bl SfAEr I & PR AN F Y& FHT| 3RIG A clicbei= b FAMA JRY BI 37 A 2
AT & PR A e arad o7 9ot 39d7 FARB 3179 701 § UhH &rd, BT a1d 3R 3= ),
B A1 A B 9T Bra A & roraife @rawe I8 &1 FE foresd, demeft 3nfg ord B 3o
AeTdr 81 el b THY WAT-IY AT 37 Bred bl SN faQivar o sef wrd 3o ¥ Foft g9 gbg
BBR A Fee A B a1d 3R o3 BId A1 7eF T H YA: clicbds Bl 51 3ol b PR
I 7 g31T1 RICSRAAUS & BRI bl B off Tyl elied o1 5 31757 o 81 37ered! sy ¥ &1
S TR b AT BT FHY BT 1| FA AT 372/al YTFeTHS b= BT g1 HdT 1

SubQuestion No : 59
0.59 3R A B I Yoielt &) gaiad 7T &--
Ans . dHAA
x 2. &dT
x 3. AfgArIR A

X 4. 30377
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Comprehension:

f&T 7T Terier & 3memR 9 Agifed g4t & 3t Ifsre--

e BT S I PR AN A Y& §IT| 3RIJ A b b JIMd TR BI IdH AT &
A & PR A H TA dlibdd 1| At I Afeh 370 F91 ¥ U &, BT 9-1d 31 378 o]
B A ARA F I Bl F & OT0TdiED FaReT I &1 I for<edl, deimelt M T B Jeoid
et &1 el & THY AT LA 37 Blet bl IS faQivdr &t s1ef a7 31 & 3ot 59 gbg
AR AT Fee A HI7T §1d 3R 9 B A1 7eF o H G Npdd B 51H 5call b PR
T 7 g3 RICSRAIUS & BRI bl H off Tyl cliepda o1 5 3157 o 81 37erevdl o) § &1
29 YR P AT BT JHL 5T o1l S A& 3efal YIS el T g1 AT 2|

SubQuestion No : 60

0.60 cllddd & sfaard &I YIRS Hal J HIAT 3T AHdl o--
Ans  x 1. fJeIRATE & BRI Feal I
X 2. qIRd & Jeren 37fE ORI I

x 3. Tdl & AT WA I

@ 4. TS PRI A

Section : Basic Knowledge of Computer

0.61 PC &I IRIA B3 3R 3A AZR A< (cyber threat) I d914 & ferv FAyferf@d 7 I $i4-
T 39T AP &7

Ans | x 1. SR Bl 3T Hadl i & BT

x 2. 37179 8e34¢ U & folU 309 ars-HIs Acdd § HB-ac Bl
« 3. T P13 & fAIv T IAP I1as BT 3UANT B1 3R 3¢ HIAd K9 I Igai-1

x 4. R WHREY &l S & folv BIRIRATA &l 31811 BT

0.62 fpt AT UHUY yraRuige B3 & SHWalc bl dGa- & folv f6d 29 &1 39T fpan
ST 9rfge?

Ans 1. Design
x 2. Home
x 3. Insert

x 4. Transitions
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0.63 MS UHRId ¥ adar Wsefie &) e 31 & fov Fgfafaa & I &19-3 TRr &1 yra fean
ST drfge?

Ans x 1. Format > Print
« 2. File > Print
x 3. Edit > Print

x 4. View > Print

0.64 fgferfad & & or-l, foraay 3ifaRfeT Ren &I fadydar g2
Ans | x 1. 3IP] 3UANT G &Y I T (Apple) S UR BT ST &1
x 2. I8 fd38IsT & (Windows kernel) TR 3memf¥d &1
x 3. I8 U Fallss A1 3R Rwen gl

o 4. T8 AU RN 3R JReaf & e 711 S gl

0.65 314 33T (Outbox) BT B3 A ABdIydd As (send) & JATdl &, dl T dl 8?2

Ans | x 1.98 29I Bics? X Tall STdT gl
X 2. Ig 3csiad 7 31fAfAd &Il db 8l &
« 3. T8 IS WIes? (Sent folder) H Tall AT &1

x 4. I XAk fSefie & ST gl

0.66 WAN dcHf &, 'UjIfl (latency)' o &1 T A 82
Ans | x 1.9¢a® &I Ifd
« 2. 52T U3 3R Ui &3 & aid [deid
x 3. Ufd &1 37 TbA arell 31 &bl g
X 4. cdd Pl gram
0.67 fHfef@d & I $I19-A1 IS AidHe, MS ds sipgic § HIR Bl U A< a1 3R o A1
& fore 39T fpan iraT &2
Ans 1. Ctrl+Left arrow key
x 2. Alt+Left arrow key
x 3. Fn+Left arrow key

x 4. Shift+Left arrow key
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0.68 MS Word T, f&fl 93 Siqyi¢ UR Usdig e Uf3fe B3 6l MaeqHdr g1 3UH 3HelI-
el BIFfET F A1 WRAMpD SRS B g 3R dGal-1 a1 A1 & Ay S 3R
dIses®Is (characters and wildcards) &1 3G9IV ST AT &1 30 B3I & fore fAg o
& A TO1 BT ITAIVT BT ATfRU?

Ans | x 1. File 2§ OX 37T, Options & Aciae &3, 3R USARE caRe VIS HIar &l Jam 1|

x 2. Home ¢§ TR 37T, Find &I Jalde &, dT TR 3R HIH{CT §a- & ol Replace fdded &I
UG B |

« 3. Home ¢§ TR 37T, Replace &I Jalae &3, Find and Replace SIIANT sfad § More TR faeid
B3, R dIgeehls b A2 Format and Special fded T 39T HI |

x 4. Review ¢§ U 37TV, Advanced Find & Jclae &, dT TaRe 3R BIHfT gga- & forw
Replace fd&cq &1 39T B |

0.69 UHUY 93 ¥ Ay ¥ A fHy fAbey &1 3TAT, WRIITP & 910 3R 10 a1 arfsff o NfEd
B3I & fore fear rdr &2

Ans  x 1. 0% (Left)
x 2. Y (Center)
¢ 3. SIRRWIE (Justify)
x 4.%122 (Right)
Q.70 UHUY ds siqgic #, g 7 § $i-Ht AT A9 dF (Section Break) ¥ 3RSl &Il
e?
Ans  x 1. Odd Page
« 2. Common Page

X 3. Even Page

K 4. Next Page
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Q.71 UHUY 38151 10 § @Rd ARPIRIAT (quick access) & felt YFIhI 3TRR YT HU 14
didl UftTdb Al @1 dai T (pin) B Abdl 872

Ans | x 1. Req Uigdist (System Properties)
« 2. IR (Taskbar)
x 3. ®eld U=d (Control Panel)

x 4. {33189 #ASR (Device Manager)

Q.72 f&3®I3 71U S8d (Discarded emails) 6T Bice? ¥ YASd ald &2
Ans  x 1.3¢ Bl

o 2. ¢ Bles

x 3. 3IH Pleay

x 4. T Blesy

Q.73 oI 39ANT 3MHAR R 3N 321, 3 yfore ¢ a1 3iif3d Rpifdr o1 dudla

&1 & forv fBan Srar &
Ans x 1.JPEG

x 2. PDF

x 3. XLSX

¢ 4. MP3

0.74 Ffaf@d 7 I $I9-31, 3BT IR SRR Vel b BT U Blel ATHIF XYy 872
Ans | x 1. MBI (Notification)
X 2. TRPER (Taskbar)
x 3. %T¢ §¢ (Start button)
@ 4. 38 (Icon)
Q.75 fAaferfad & d SI-AT WeTPid, ARG A Jd? A SAA U B34 & fere 39T fpan
SITdT &2
Ans  x 1.FTP
X 2. HTTP
X 3. SSH

v 4. POP3
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Q.76 UHUY d8 2019 ¥ 'Section Breaks' &1 3UAN &1 &I FT 389 87

Ans | x 1. gcic 9ige (bullet points) U8 &3l

X 2. TR Pl gIEcAISC BRI
x 3. 71 U] ~9¢ AT
o 4. SIFgHC I [Afg BiAf & fore Jaert | faunfsrd &3

Q.77 R1gel 4 MS Excel & del & 39t STHATY 14 Feb 2009 Yfa® $11 371 TeTdl & Format
Cells fd®eq § Il B PR dqeib General B f&ATI 39 Al T Ygffd Hom?

Ans | 1.07Jan 1900 I 3§ d sid gob AT BT A
x 2.3f¢ (Error)
X 3.01Jan 2009 I 31§ A% did gob & T T
x 4. BIs I ATefBd A=A

0.78 UHUY YTaRyisc |, 39 ¢RC §idd (text box) & Hidy e &I &I 73T & IPd &7

Ans | x1.'Slide Master' & & 3917 B3I

¢ 2. R Bl Aclae PP 3R Home &9 I TSRS HTRM BT B
X 3. ST ST P W38 IR Tl i W IR $97 BRob

X 4. SR YR B UMAHLA 3718 Bdb

Q.79 W3R Jra&m, FHfefad & & $19-I1 19 YgI-Hel Sdl &2
Ans | 1. % &I dif) B0

x 2. 950 B B HIAT

x 3. 3YIPTHAT MYl

x 4. IR 9 9419

0.80 MS d@s 2010/11 iggHe & faBice Wi 3R Bi-e ATS T &Xdl 8?2
Ans | o 1. B = Hellal 3R B AT8T = 11

x 2. BT = Helisl 3R Bie Jqrssf = 12

x 3. I = 2T12RT =} AHF 3R i< AT = 12

X 4. B = 28R = A 3R B AT = 11

Section : Quantitative Aptitude
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0.81 24 II3M &7 31d 75 &1 W 12 I3 &7 3d 72 & a1 3ifaq 13 Ywasi &1 3itud
80 gl Afg 12T J&=m &1 geT faar e, dY oy Y&=A137 &1 3d (GeMed & ¢l T dob
quiifed) grd Hifarel

Ans  x1.75.68
& 2.73.74
x 3.74.82

x 4.76.24

Q.82 U 3gHl 319 3 BT 64% W Hdl &1 AfE 3B A H 25% B gfg &l & 3R 3BT
& 10% SedT &, dl 3P dad # Ufererd I (GAHeId & iR AT dd uiifepd) fea-
&?
Ans | x1.56.67%
x 2.57.67%
x 3.53.67%
v 4.51.67%
Q.83 U gAId #, 3 3ufiqan, ¥fer, did 3R drell #f A Ve &1 did & 50% A6 7d fiid|
OfeRT 9 drell ®1 72,000 Adl A &1ATI did P dlell A 20% 3PS 7d A | gaqr— g §

Al Pl Adard3l 7 & 80% HAdardiAl 3 #d sTel AR HI$ off 7d 31de &l 411 AAQTdl
A F gderdi3il 61 ol J@AT S1d B3|

Ans | x1.4,36,000
X 2.4,23,229
»3.4,50,000
x 4.4,23329

0.84 U% GHICR VS 4@ $I ed, 3P B4 JoI A 50% 311AP JHAlag Har & 3 3ua 3=

el WR 29% &) §e &l 8l AT 98 3195 BT oy AfSfd HdT &, dl 4@ &1 YAl g7 R #)
T 8?2

Ans . »1.4,500
x 2.4,380
x 3.4,460

x 4.4,525
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0.85 U 3MAd $I cidis § 20% b1 Sl B AT 81 ATE 30D A31S 7 35% I Ifg b1 et 8,
dl 3Id & &3%d § feda gfaerd akad gen?

Ans  x1.10% 3G
x 2.10% BHI

v 3.8% 3G

x 4. 8% HH

0.86 BH 83%, 64% 3R 79% b1 dI-1 Bflid Gl & RIIR Uhd UfdAad g [GAHd P 1 314
d®] grd HIfare|

Ans | x 1. 88.9%
X 2. 98.1%
¥ 3 98.7%
X 4. 90.2%
0.87 U RJf3id A< b Jo HIAd 8,100 &1 AP HIAd IR 12% $I §e 61 3Tl & 3R R
3T 25% b1 Ifg 1 sirdt 81 i A2 61 48 Hiad (F ) §ird HIf3el
Ans | 1.8910
x 2.8,410
X 3.8,210
x 4.9,410
Q.88 U Afth &R &Y fqudd f&2a1 & 8 km/hr a1 &1R1 b1 f&2AT § 12 km/hr &1 @1l F 19

eIl Abdl ¢l 39D gRT RBR 3icl § AT1d Tl B dlel aAT &RT I Alel T 3q4Td ST
$ifarel

Ans  x1.2:5
& 2.5:1
x31:5

x4.5:2
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0.89 G x BT 4% = 240 &, dl x A ¥ I fPUd WK &?

Ans  x1.6100

x 2.12100
x 3.12000

v 4.6000

Q.90 U® Blel ursy fdl & @l 6 €2 T WR &dT &, 4P UPb &1 UTsY 394 50% daft I &1
Pl ¢l IfG 3 BIC 9139 31X 2 &2 4TSy fild &3 &P &l WRd &, dl ¢ &I WA H fod-r
T ePhIm?

Ans | x1.1%c120 fA4e
x 2.30 e
x 3.40 e
¢ 4.189a
0.91 3IRTH 4 20% B §C UId B & 9 32,100 7 UP I Wial, olfp Y e & d1q Bl
$IHd YR 5% b1 &3 A GST &I PIdl fHATI DI BI 3ifbd e SlTd BIf0I
Ans  x1.32,480
x 2.32,490
x 3.32,520
v 4.32,500

0.92 fPHfafad ¥ A S-dt Az I 91 82
9 39 53

5
8’ 23" 72’ 54

Ans 1.3
8

s2 53

54

x3. 9

23

x 4. 39

72
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0.93 A 4x — 4s-1 = 4g &, @

2x = 1 1 719 5ira HIf30|
2x+3

Ans x].i
6

0.94 |9, AIsehd AR AT U YA ST B BHE 8, 46 3R 24 & T @IT B AHA &l
i1 3 v A1y 1 Y BT G 7 2 &7 918 S BIg &A1 3R Arsevd A S G171 87
1P 4 &7 ygel o1 8IS &A1 S @ 811 7 o1 P &1 61 J@A sird Hifse|

Ans »1.132
x2.39
x3.87

x4.12.4

Q.95 A /3 = 1,73, &, a1 /75 B HI &ird SIS
Ans  x1.6.88
x 2.8.96
x 3.9.68
v 4.8.66
0.96 3 ¥ Ugd, A, B 3R C 61 309d 31y 32 9 i1 319 F 3 a¥f 413, A 30R ¢ $I 309d 31g 43
ad gft 1 319 F 4 9 91 B 61 31 (a§T /) fpa-h aef?
Ans 129
x2.31
x3.30

x 4. 25
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Q.97 U Han # 15 faenfdai & 3iepl &1 3d 46 21 I TAS fqeneli & 3ie A B f{e g,
dl =11 3R grd Sif3red

Ans  x1.30
X 2.46
x3.15

v4.92

Q.98 775, V7884 @_@ﬁwﬁrﬁﬁml
Ans 1 1342

X2 1242

X3 10V2

x4 112

0.99 U 19 @R 3 ¥ 13 km/hr & AT A I Abdl &1 ATE &RT &6 a1 4 km/hr &, df 19
GIRT &30 b1 fE2m 7 68 km 61 gl 0¥ B H o1 I-1 A7 S1d S|

Ans x1.3h
x2.2h
x3.5h

v4.4h

Q.10 S 3R T &I IdHIA 31y HHLE 70 a¥ 3R 50 ¥ &1 fHda avf ggal 3961 301y ST 3qu1d 11 :

o 7497

Ans x1.14
x 2.12
x 3.18

w415
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